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Installation

Installation

Installing and Registering GraPL

You may download GraPL from the internet, but you will need to register your copy
before you can save data or copy the completed charts to the clipboard. Having run
Setup.exe from your download, you will be able to start GraPL in the normal way from
Start,Programs or simply by double-clicking on the GRAPL.EXE file. It will also be
associated with any files with the .GPL extension, so you can double-click these as an
alternative way of starting the program. You may like to add a shortcut to GraPL to your
desktop - just drag the .EXE to the desktop to have Windows create the shortcut for you.

Registering your name and licence key

The first time you start GraPL, you will see a registration screen like this:

Welcome to GraPL

2 Thiz copy is hat registerad.

o

4 Flease enter your registration details below:
|lzer narme: I

Lizenze kew: I 2 Cauzeway Graphical Systems Lid. 2002
Beqister & Load proagram ... Demo only .. |

When you purchased GraPL, you will have given us your name (such as “Adrian Smith”
or “Ampleforth College”) which will have been used to generate a unique licence key
(such as QWE321) which will either have been emailed to you, or is noted on your
printed invoice. You should type in your name as you gave it to us (although the key-
generation process does ignore capitalisation and punctuation) and the licence key, and
hit Register. If you just downloaded a trial copy, you may proceed to try out the
program, but you will not be able to make clipboard copies, or save any completed
charts.

The registration information is saved in a file USERINFO.DAT in your installation
directory. You may copy your installation to any other computer which you use
regularly, and it will remain registered to you. If you want to retain any other settings
(such as the screen layout, templates folder etc.) you can export the registry key
Causeway\GraPL (found under hkey_current_user\software) as a .REG file and copy this
to your second machine. Just double-click it to import the settings into the registry. The
first time you use GraPL on the new machine, you will see a message telling you that the

© Causeway Graphical Systems Ltd 2004 2



Installation

Flexgrid OCX has been registered, and there will be a short pause before GraPL starts.
Alternatively, just rerun the installation from the original download and re-import your
registry settings as above.

Running from a network server

If you have a network licence for GraPL, it should first be installed and registered (as
above) by your network supervisor. This licence key is then valid for anyone who has
legitimate access to the installation directory on the server. There is a copy of the
Flexgrid OCX file kept in this directory so that when a remote user starts GraPL for the
first time he/she will see the message “Registering the Flexgrid OCX” which must be
known locally to Windows on each desktop computer which runs GraPL. The OCX is
not copied to the desktop machine in this case — the assumption is that the server will
either be a mapped drive or a fixed UNC name such as ‘\\gandalf\cdrive\shared\grapl’
and that the registered OCX will remain in the same place in the future. If the GraPL
installation is moved, all the desktop users will once again see the registration message
the first time GraPL is restarted.

Of course GraPL will start (and run) a little faster if it is installed locally — you may allow
individual users access to an installation directory on the server (just copy Setup.exe
from the download) and inform them of the correct user name and unlock code.

Any visual settings (screen layout etc.) are saved in the registry on the desktop computer,
and so remain personal to individual users.

Printing a Set of Manuals

If you need more than one set of manuals (or you purchased GraPL over the internet at
the ‘software only’ price) you may download the necessary files from the
www.grapl.com/support area on our website.

Manuals are provided as PDF (Portable Document Format) files so you will require a
suitable version of Adobe’s Acrobat viewer. It is very likely that you already have this, so
check by double-clicking one of the PDF files before you try installing the viewer. It is available
as a free download from Adobe’s web site at www.adobe.com.

Manuals are included in A4 and US Letter formats, designed for single-sided printing and
left-edge binding.
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Getting to Grips with GraPL

Getting to Grips
with GraPL

This chapter describes the GraPL user-interface. If you are
comfortable with normal Windows conventions, you can safely
skip most of it and go straight on to the tutorials. However,
please do take time to learn the keyboard shortcuts and some of
the quick ways to enter bulk data into the datasheets.

Introducing GraPL

GraPL is all about making useful graphs from
sheets of numbers. You can use it to do some
simple calculations, but it seems much more
likely that you already used Excel for that and
all you want to do is make a nice chart so you
can drop it into a Word document or a web

page.

This part of the documentation is designed to show you how to accomplish simple tasks
such as getting data into the program, building up a chart definition, and saving the
finished item for printing or screen display. Where appropriate, it is linked to the
reference manual which describes all the chart types, chart properties and calculations in
detail.

The Structure of a GraPL Project

Each GraPL project contains one or more chart definitions, one or more data-sheets, and
any number of miscellaneous text items (notes, glossaries etc.). Typically you will have a
single datasheet, and a few chart definitions to plot the data in different ways.
Sometimes it is convenient to have several datasheets (maybe data for different years) in
the same project so that you can easily switch between them. When you begin a new
project, it will have one chart and one sheet preset for you. You may want to open one
or two of the sample projects (found under Help,Samples) to see how these have been set
up with charts and data.

The Main GraPL Screen Layout

GraPL uses the left-hand side of the screen to develop the specification for your charts,
to enter data into a collection of tables, and to build simple calculations which you can
use to select and summarise the numbers. The three tabs on the left all work in similar
ways:
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the Charts tab can hold one or more chart specifications. You page through these
from the dropdown list at the top of the panel. Initially you will find that you only
have one chart here — you can use the Insert menu or the corresponding tool
button to add as many chart definitions as you like here. As you page through the
charts, a preview of the current definition is shown on the lower right of the main
screen — press F12 to toggle this to occupy the whole right-hand part of the screen
or double-click it for a full-screen preview.

the Data tab holds one or more data sheets. You page through these in the same
way as for the charts, and you can add new sheets manually with the Insert menu,
or create them from data already on the clipboard. This is probably the most
convenient way of bringing in data from Excel.

the Text tab is where you store simple text elements such as a company name for
footnotes. You can also use this to edit chart notes, to store SVG elements such as
symbols or filters, or to develop JavaScript elements for attaching to chart data.

You link the data-sheets to the charts very simply — wherever GraPL expects to see some

numbers (a plotting command, or a chart property such as ‘Pie explosion’) you can type

a column name into the specification sheet:

Chatts | Data | Test |

Chart1

[

Object/Property

' alue |

B New Frame
© Shle
|| Margins [thi)
-2 Heading
|| [ Subhead
“.[@ Foothote
= Fie
Fiechart style
Pie explozion
H-labels

... which names a column from any data-sheet. If you can’t remember the column
names, just hit the ‘..." button to see a complete list. In this case I just had the columns

00,432,324

YWiped.Boxed
42.48,36.18

from the new file, so it was easy:

Chartz Data ITE:-:t I

Sheet]

~IE|S|

For more details on editing the chart specification please refer to Editing the Chart
Specification (p.14), and you can find out more about the data sheets in the section on
Entering and Organising Data (p.8). For now it is enough to know that you can refer to
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columns by their name (capitalisation does not matter here) or as “Sheet1.col3” if you

have several data sheets with similarly-named columns in them.

Adding Charts and Properties

The right-hand side of the main screen is used to show a thumbnail view of the current

chart, but it also acts as the source window for new charts, extra properties and

calculation elements. Here are a few of the chart types you can have:

Templates  Chart elements l Settings] F'mperties]

B b B

Barchart Linegraph Scatter Pie
bt @ = |ma
Bowwhizker Wann Gantt Step

@

Palar

&

Trace

£33

Dial

%

T ower

lLal

*-Bar

E];’;l

Cloud

IS N

Min-tdax  Freguency
)
Responze Multiple

To add a chart to the current specification you can drag it across with the mouse,

double-click it or simply select it and press Enter to have it added to the end of the

current set of commands. It will begin by showing a dummy dataset called {data}, just to

give you something to look at. Probably the first thing to do it to change this to reflect

the column name you actually want plotted. You will also find that all the charts bring a

‘sensible’ set of properties with them, but if you want to add something extra, you can

use the Properties tab to append anything else that you need:

Templates] Chart elements] Settings Properties

Heading Key attribs tizzing valle
Heading fant ey frame Page-labelz
Heading ztyle ey font Fiechart style
Hints K.y format Pie explozion
Heading nudge Key stule Fie centre
Hyperlinkz Label font F adii

ey Label style Subhead

L]

Subhead font
Tips
Walue tags

Where
*-caption
H-caption font -war
F-farmat

#-labels

#-label font

“-caption font

'labels
'-label

| b
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Here I have chosen to modify the formatting of the value labels — again you can drag or
double-click the selected item to add it to the chart sheet. If you know the format of any
property, just type it in, otherwise hit Ctrl+Enter (the shortcut for the ‘..." button) to get
a handy pop-up screen which tells you what GraPL is expecting. In this case it is an
example of the desired format in standard C# or VB style:

Chatts | Data | Test |

Chart1 [~

Object/Property |"»-’alue |
E New Frame 00432324

|| Style ‘wiped Boxed
|| | Margins (tbl]  42.48.36,18
|| @ Heading
|| @ Subhead

@ Foothote

= Pie coll

Fiechart stwle  aluez
Pie explozian col?
H-labels

g e,
Value format | FNIGNS )

You can also press F1 with the cursor on any property or chart to go straight to the
appropriate topic in the help file.

Using the Status Bar

The various fields in the status bar are used to give brief extra information about the
current property and chart. As you move around in the chart specification you will see
an expanded version of the property name in the left-hand field. When you are in a
datasheet you will simply see the [col.row] index of the cell you are in.

The field in the centre is used for transient messages (such as the date and time you
saved a file) and for extra help on menu items. It also shows any problems with
calculations (such as mis-spelled column names) which have prevented a calculation
from running.

Finally, with the default preview, you can use the right-hand field to read off the (x,y)
co-ordinates in any 2-dimensional chart. Simply move the mouse to the data-point you
are interested in to see an exact readout of its position. This is not available with the
VML, SVG or PDF previewers.

Customising the main screen

The left/right halves of the window are separated by a splitter bar, as are the two panes
of the right half. Set these up how you want them and choose ‘Save settings now’ from
the Options menu. You can choose to hide any of the right-hand tabs from the Options,
Preferences screen, and you can make the usual selection of icon sizes and ‘Details’ view
for the various tabs.
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You may have any of these choices saved automatically on exit, or only when you
choose ‘Save now’. For maximum working area, you might also decide to hide the
toolbar and status bar from the ‘View’ menu.

Documenting what you did

You can use the File,Project properties command from the main menu to make any
general notes about the GraPL project as a whole.

# Project Details M =]
Project Hame ... 0K
Catizel
Author .
|.i'-.|:|riar'|

Mates [uze <Cri+Enter: for a newline here] ...

Thiz project uses a simple datasheet and zome calculations to plot a running average =
af the MPGE returned by aur B aver fram new.

There iz a distinct cyclic pattern show here, which could be the time of year, or the
gEmice interyal.

[

+ | Show this gummary when the project i opened

It might be a good idea to tick the option which shows this summary whenever the file
is re-opened, as this can act as a good memory-jogger when you go back to working on
some data you haven't seen for a few months. When you select File,Overview you have
the option of printing this summary along with any notes you made about the charts,
datasheets and calculations.

Entering and Organising Data

Before you can make a useful chart, you will clearly need to tell GraPL the numbers that
you want plotted. When you first add a chart element (like a lineplot) to the chart
specification, GraPL sets its data property to the placeholder {data} which will generate a
short series of random numbers. This is enough to let you explore the chart formats, but
at some point you are going to need some real numbers to work with.
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Adding a new data sheet

GraPL can have as many data sheets as you like, stacked up behind the ‘Data’ tab on the
left-hand side of the screen. A new project will start with one sheet, called ‘Sheet1’
which you can rename and modify to suit your data. Alternatively, you can add a
completely new sheet and work from there. Select Insert,Data sheet (or click the
appropriate tool button) and you will first be asked if you want to copy the definition
from the current sheet; assuming you say ‘No’ you will now need to set up the sheet

properties:
s Datasheet Properties
Sheet Mame LColurmnz . Drefinition of column - Coll
|Sheet2 o T i‘ Type . width .
3 columrs Cal2 |T:<t ﬂ | 72
Col3

2 -]

Unecralled Cals: D : Calculated by ... Cal... | Func ...

[ Start with Form wiews

[ Auto-add new rows

[ Auto-add new calurng |

[ Fit prints to 1 page wide j Yalid choices, separated by commas

lTl = | ‘ Usze F2 [or just overtype] ta edit a calumn name. —
anee Drrag the rov stubs to re-order the columnz Q_D =

You can always get back to modify these settings by selecting ‘Properties’ from the right-
mouse menu on any sheet or by pressing Alt+Enter when the data-tab is at the front and
your sheet is selected.

The various fields on the Datasheet Properties screen allow you to:

e change the sheet name. It is best to keep these reasonably short unless you are
careful to name your columns uniquely across all the sheets. Otherwise a plotting
command like Barchart “My First Experiment.Time” could get tedious to work
with. In general, choose short, meaningful names here and definitely avoid
punctuation characters like ‘,” which is used to separate column names in the chart
specification.

¢ set the rows and columns in the sheet. The rows will be extended automatically
when you cursor down from the bottom row, so this can just be a rough guess. The
columns are shown in detail in the table to the right, which has as many column
definitions as you have columns in the table.

e make one or more columns non-scrolling. This can be very useful if you have a
wide sheet and want to keep one or more of the leftmost columns in view when
you scroll across.

e Open the Data tab in ‘Form’ view rather than table view for this sheet. This is
useful if you have a very wide sheet, as it is much easier to edit one row at a time.
You can always toggle between the views.
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e Allow GraPL to add new rows (and possibly columns) as you type. The default is to

auto-add rows only.

e force prints to be scaled to fit on no more than one page wide — again this can be

useful for large sheets.

The columns themselves are set up in the panel to the right — here is another example

with rather more columns in use:

s Datasheet Properties

Sheet Mame LColurmnz .
|Height$ Mame -
Mame
5 columns Date
: Height ]

Drefinition of colume - Height

Tupe ... Wwidth ..

|Num R 43

Age
Unzcrolled Cols: D :

[ Start with Form wiew
[ Auto-add new rows
[ Auto-add new columns

[ Fit prints to 1 page wide

o]

Cancel ‘

Usze F2 [or just overtype] ta edit a calumn name.
Drrag the rov stubs to re-order the columnz

Decpl |[auta) Units: |om
Calculated by ... Cal ... | Func ...

j Yalid choices, separated by commas

Motes ...

In many ways, this part of GraPL has more in common with a database system (like

Microsoft Access) than with a spreadsheet. Each column has a data-type (like numbers or

dates) and will interpret what you type in a way which is appropriate to the column. In

particular it is important to put dates into date-columns so that you can use a date

column as an x-axis and have it correctly labelled and spaced.

In the example (from the Heights file which is included in your Samples folder) you can

see that we have 5 columns defined as follows:

Column Data type Units
Name Txt

Date Date

Height Num cm

© Causeway Graphical Systems Ltd 2004

Notes

Text is the simplest column type — you can put
anything you like into a text column.

Date columns expect you to enter dates in the
normal ‘short-date’ format such as 25/12/01 - the
ordering of days and months is determined by your
Windows regional settings. If you enter two
numbers only the default is ‘this year’ and a single
number is taken as a day in the current month. Also
you can enter ‘t’ to mean ‘today’.

This is a simple numeric column with no particular
formatting. It will accept any reasonable numbers.
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DoB Date Another date column. Another advantage of date
columns is that you can do arithmetic with them,
in this case subtracting two dates.

Age Num2 years Another numbers column, but this time we only
want to see 2 places of decimals.

In addition to these types you can have ‘Time’ columns which expect entries like
“10:32” in hours and minutes, ‘GPS’ columns which expect locations like “23:54.2W"
and ‘OneOf’ columns which restrict your entries to a pre-determined list. The final
column type is called ‘Suggest’ as it behaves very much like the normal text column but
comes with a drop-down box in the data-sheet to suggest likely entries.

When you create a new data-sheet by pasting data from the clipboard or importing a
.CSV file, GraPL will normally be able to guess the column types for you, but you should
always check the list in the properties panel to be sure.

Adding notes about the data

If you want to make some comments about the datasheet, select Notes from the right-
mouse menu and add any comments you like as free text. These will be printed with the
table, or appended when you save it as a webpage, so this is a good place to make some
general comments about each datasheet.

Entering data into the sheets

Obviously, you can just type into the cells, and use normal Copy/Paste to get data in
from elsewhere. However there are some useful shortcuts to help you fill text, numeric
or date data quickly:

e Copy commands - the symbols * < > “ (the last one is the ditto symbol or double-
quote) following a number will copy it in that direction to the end of the table.
Text can be copied upwards or downwards only.

¢ GrowBy commands - you can fill a column with a linear series by typing an
expression such as 10g2 into the top cell. This reads as ‘10, grow by 2’ and will fill
down from the cell with 10,12,14 .... and so on to the end. Similarly to grow each
cell by 5% compound you can enter ‘100c5’ which will be 100,105,110.25 ... and
so on. You can also use this syntax with dates, so to make a weekly series, try
‘25/12g7’ in a date column. The ‘GrowBy’ interval defaults to 1, so ‘12g’ in a date
column will run forward in days from the 12th of the current month and ‘tg’ is
days, forward from today.

If you have formatted columns with an explicit decimal setting, then your numbers will
always be shown with the required decimal places, however they are always held
internally to the full precision of the computer (about 15 significant figures), so any
calculations based on these columns will not suffer from loss of accuracy.

To enter a long series of numbers into a column, type each number and press Enter to
move down to the row below. This will automatically add new cells at the end of the
sheet as you need them. If you prefer, you can create a large number of empty rows by
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holding the down-arrow key, then go back and fill these in with numbers. You do not
need to worry about removing unused rows, as GraPL will clean them up automatically
before saving the data.

To delete rows one at a time, hit Ctrl+D (or Ctrl+Delete) with the cursor anywhere in the
row. To delete a block of rows, select them (using the mouse or by holding down Shift
and using the arrow keys) and select Delete Row(s) from the right-mouse menu on the
row stubs, or from the main Edit menu. Pressing ‘Delete’ simply clears the data in that
cell.

Working with wide tables

It may be more convenient to see each row of the table laid out ‘form’ style. You can

toggle between table and form view at any time with Ctrl+T and Ctrl+M respectively.
GraPL will remember which row in the table you were working on, and automatically
open the form view at the correct record.

Re-ordering columns

You can re-order your columns in the DataSheet Properties dialogue by dragging the row
stubs in the definition table. Alternatively, choose Options,Preferences from the main
menu and select the check box for “Re-order columns by dragging headers”. This option
is off by default as it makes it hard to select multiple columns by ‘drag-selecting’ the row
headers.

Adding or removing columns

Use the right-mouse menu on the column headers to insert, append or delete columns
from the datasheet. You will be prompted to fill in the column name and datatype when
you add a new column. Enter the units if you know them as these provide useful
documentation.

s> Column Properties

Column name ... Width .. 0K
| 39 Reset |

Colurmn tupe ... Decpl... Unitz ...

|Num j |2 j |pears

Calculation [exprezsion bazed on other columns] ..

|[D ate-Dob]/365.25 Cal... | Func ...

Cancel

Walid entries for the 'One0f and 'Suggest’ types [zeparate with commas).

This dialogue can also be used to change the properties of a single column - it is also
available from the right-mouse menu on the column headers.
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Sorting the datasheet

Choose Options,Preferences and turn on the checkbox to allow ‘one-click’ sorting on the
column headers. Now, whenever you click on a header the entire table will be sorted
using that column as a key. The sort alternates between ascending and descending and
preserves the order of any rows where the keys are the same. This makes it very easy to
arrange your data (say) by date within name - just sort by date first and then by name.
You can choose exactly how you want to sort any column for the right-mouse menu, for
example you might want an alphabetic sort on the last word to get a list orderd by
surname.

Once you have arranged your data in the order you want, it is a good idea to disable sorting
(and column dragging) as it is very easy to do these actions by accident on columns which you
didn’t intend to click.

Referring to data values in charts and calculations

You refer to any data column simply by entering its name against the plotting command
or calculation input. The names are case-independent, so you can use ‘AGE’, ‘age’ or
‘Age’ to refer to a column called ‘Age’. If the same column name occurs many times in
the data (you might have one sheet per year, with columns called MinTemp, MaxTemp,
RainFall) you should prefix the columns with the sheet name, e.g. 1999.Rainfall. If you
do not prefix the name, GraPL will pick the first matching column, working forwards
through the sheets.

You can refer to an entire datasheet (such as the output from a CrossTab calculation)
simply by giving the sheet name. This is exactly the same as listing all the (named)
columns — CrossTabs intentionally leave the first column un-named so that you can
easily select just the data portion.

GraPL creates a small number of special scratch variables for you:

e $sheets — this simply lists all the sheet names in your project
e $data — the entire collection of datasheets, as a list of tables

e Sheetn$cols — one variable for each sheet, which lists the column names in the
sheet. This could often be used to form the key of a barchart.

¢ Sheetn$notes — one variable for each sheet, which has the notes you may have
made about the sheet. This could be used to add a note to a chart based on data
from the sheet.

e $coeff — the coefficients from the most recent Modelfit (intercept, linear term, etc)

o $fitted — the fitted y (or z in a 3D scatter) values. This will be a vector of numbers
exactly matching the plotted values in length. Missing values in the data will be
included (as missing values) in the fitted data.

e $resid - the residuals (differences from the data and fitted values) as above.
You may reuse scratch names, or even overwrite the names GraPL creates for you if you

don’t need them. Use the Console window (View,Console) to inspect the contents of a
scratch variable.
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Printing and exporting data

You might like to print out all or part of a datasheet for checking, or export it as a text
file (in tabbed or CSV format) or possibly as an HTML table for inclusion in a web page.

Use the right-mouse menu on the body of the table, or choose the appropriate tool

button here. If you select more than just a single cell, the export will give you the choice

of exporting only the selected cells. The columns will always be arranged in the order

shown in the table, but for very wide tables, any ‘non-scrolled’ columns will be repeated

on every page of the printout. Any notes you made about the data will be included

below the sheet when you print it, or export it as a web page. Exported CSV files only

include the column headers and the selected data.

When you choose ‘Export to Clipboard’ from the right-mouse menu GraPL will copy the

entire table, including the column headings, but not the sheet notes. You can now paste

this straight into Excel or Word and have it easily converted to a Word table.

Editing the Chart Specification

The chart specification sheet is the key to the power of GraPL, so it is worth taking time

to understand it well and to learn the keyboard shortcuts so you can use it efficiently.

Here is a typical chart (from the ErrorBars template) which illustrates most of the

important points:

#» {untitled) - GraPL

Eile  Edit  Insetrt

Wiews  Data

Preview

Opkions

Flugins  Help

=] E3

PSR ER s~ | X8 | vty aabe | E-8

Charts |Data | Test | Calc |

Error bars j
Object/Property | Walus |

| |[] Hew Frame 00432324

| Shle boxed.wipe

| tdarginz 42.48.36.18

|| *ME:Heading; Sample Timese...i

| |E Linegraph {data}

= Stule lines

- E‘---E| Anez Black.1,50lid

| | Labelfont  Times,8Black

L Caption fort  Timesz 10.Teal

- Gridlines HCBDEDE Solid,0

| Datumlines  Green,Dash, 0.3

| L E] Hefis Days

I = Uptake

| |E EmorBars {datab+3 {data}-3

Sty

Sample Timeserie:

s with Evrorbars

|[4] Chart heading

| SVG (Chltozoom)
£

The left-hand column (labelled ‘Object/Property’) contains a mixture of charting

commands (always shown in bold) and the properties which apply to that command.

You can see that there are three of these commands in this example:

© Causeway Graphical Systems Ltd 2004
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1. New Frame - this is always the first command in a GraPL chart definition,
although you can miss it out if you are happy with all the default settings. It sets
the size of the paper (the units are points, where one point = 1/72”) which
defaults to 6” by 4.5” which is ideal for pasting into Word documents. It may also
set the margins (where captions and axis labels go) and other fixed items like
headings and footers.

2. Linegraph - this draws the first chart on the frame we have just defined. At this
point you have nailed down the axes, so you can do as many more charts as you
like against the same set of xy co-ordinates, but do remember that the first plot in
the GraPL specification sets the axes up for all the rest.

3. ErrorBars - this uses the ‘Max-Min’ chart element to superimpose a set of vertical
lines through each data point. Because it is the second command in the set, it
inherits all the settings from the linechart.

Notice that as you add these verbs, GraPL automatically cycles through a preset
collection of colours and line-styles — you can customise these collections by adding
items from the Settings (p.29) tab if you need to.

Working with the Property Tree

You will notice that the verbs and properties are arranged in a tree-structure so that you
can ‘roll-up’ the parts you don’t need to see. For example if I click on the ‘-’ box beside

the Axes property, the details of the axes will be hidden, giving me more space to work

in.

Wherever you see a ‘+’ in the tree it means that
Charts l Data | Text | Calc |

| Error bars ﬂ

there is more detail hidden here. To open up a

branch of the tree you can click the ‘+’ with the

Object/FProperty | Walue . . .
D New Frame  0,0,432.324 mouse, or press Shift+Enter. Pressing Shift+Enter
L Shyle boxed wipe again will close up an open branch - this means
M argins 42483618 you can explore a tree very efficiently with the
‘@ Heading Sample Timeserie: keyboard.
&l Linegraph {data}
Style ines Note that when you build up a chart ‘by hand’ by
] Axes Black.1.5alid
i Labelfont  Times,8Black dragging in properties from the Properties tab,
Caption font  Timez, 10,7 eal they are always added at ‘level-1’ in the tree. You
Gridlines HCEDSDE S olid.0 can tidy up the indenting using the Tidy
Indenting option from the right-mouse menu.
LT :-:i; |ptak.e
5 ErmorBars ek el The other important keyboard shortcut is
Style lines, emorbars Ctrl+Enter, which has the same effect as hitting

the ‘... button on any chart definition or property

line - it brings up a little dialogue box to help you fill in the right information.
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For example:

Editing - Linegraph: Style
[ Trend line [ Halo markers
[ Relative data [ Growth curve [ Markers [ Crizp lines
[ Index to 100 ™ Ontop ™ Rlisers
[ Forcezero [both] [ Model kit [ Surface shading [ “alues at markers
[ Gridlines [ Annotate model [ Filled lines [ Arrowheads
[ Clipped to axes [ Segmented | Redraw anes
[ Cells created [ Framed axes
] Cancel Reset Help

This is what you will see when you hit Ctrl+Enter on the ‘LineGraph,Style’ property. Of
course you could just type any of the keywords in to the edit field (many of them are
pretty obvious) but this little pop-up lets you know exactly what is available here.

Actually, there are two checkboxes ticked — lines are turned on and so are the axes.
However the ‘Axes’ option is the default setting so the word ‘axes’ was not required in
the property. Try turning it off from the checkbox to see what happens!

Every property pop-up box has a Help button and a Reset button. The Help button has
the same effect as hitting F1 with the cursor on that property and the Reset button has
the same effect as hitting Ctrl+R - it sets any property back to ‘factory defaults’ which is
useful if you can’t remember the sensible initial values.

Adding and removing Objects and Properties

You can add new chart elements to the current specification by dragging them over from
the ‘Elements’ tab (or selecting the chart icon and pressing Enter or double-clicking it)
and new properties from the Properties tab.

Alternatively, use Insert,Chart element from the main menu, or from the right-mouse
menu on the specification. If you want to add a specific property, you may also use
Ctrl+I to pop up a list showing only those properties which are relevant to the chart
element you are editing.

You will notice that when you drag a property, a heavy black line is drawn on the
specification to show you where it will be inserted when you let go the mouse — you can
drop a new property absolutely anywhere. When you drag a chart, the ‘target’ highlight
skips between the other top-level objects as it makes no sense to add (say) a barchart in
the middle of the properties belonging to a linechart. By default, a chart element will
bring a default list of properties with it (note the small ‘+" attached to the mouse pointer)
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- if you just want the chart on its own, hold down Alt as you drag the chart icon over to
the specification.

If you prefer to run the preview full-size, you can select View,Property window from the
main menu to bring up a free-floating window of the full property list. Properties can be

dragged from this in just the same way as from the Properties pane, so this may be a

more comfortable way to work if you have several unrelated properties to add.

You can also drag over a new template — because this completely replaces the existing

specification the highlight always sticks to the very top of the sheet. If you realise you

didn’t want the property you are dragging, just drop it somewhere off-screen, or press

Escape. The sheet will scroll automatically if you need to drop something below the

bottom (or above the top) of the visible part.

To remove an unwanted chart or property, click on it and press Ctrl+D (or just Delete if

the cursor is not actually in the moving edit field) or use the right-mouse menu. If you

remove a ‘parent’ object this automatically removes any children, whether or not they

are hidden. You can also use the standard Windows shortcut ‘Ctrl+X’ here to ‘cut’ the

chart as you might want to re-insert it on another specification, or just move it

somewhere else.

Moving Charts and Properties around

As well as normal ‘Cut/Copy/Paste’, you can easily move charts around with the mouse

by dragging the row stubs (the plain grey rectangles to the left of all the rows).

Charts | D ata I Calc

Errar barsl

~

-.

Object/Property | Walue |
| |E] New Frame 00432324
= Style boxed, wipe

b argins 42 433618

_ 0 Sample Timeseries with Em
| [& L N {data}
||| Shle linez
W Anes Black.1 5olid
E ErrorBars {data}+3 {datal-3
Style linez,ermarbars

Here you can see that the ErrorBars chart is about to be dropped just above the

Linegraph (this will draw the bars first so the line will draw over them).

When you move a chart or property, it always takes all its children along with it. As for

adding new items, you can move a property anywhere you like, but a chart will always

skip to the end of the property-list of the chart you drop it on.

Normally, when you use the clipboard to copy a chart, you will get all the properties

copied with it, however you can choose only to copy some of the children - just select
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the rows you want with the mouse (or use Shift+down-arrow) then use Ctrl+C to make
the copy.

Drawing the finished Chart

Because you might want to change several properties, GraPL will only ‘run’ the
specification sheet whan you press Enter (on the specification sheet) or hit F9 or press
the Run tool-button. This will show the chart in the preview window at the lower right.
Press F12 to give this the whole right-hand half of the screen, or double-click it for a full-
screen preview. You can check details on the preview or thumbnail by dragging a ‘zoom’
rectangle over the part of the chart you want magnified (hold Ctrl and drag to zoom up
in the SVG preview mode).

Documenting what you did

You can add comment lines (drag the ‘lamp’ icon to the chart spec) anywhere in the
specification, as well as making notes (use the Properties command from the right-
mouse menu) about your chart. When you print the specification (again, you will need
to use the right-mouse menu here to access the Print command) any notes you have
made will be printed along with the complete property-list in a 2-column table. You can
also select all the rows and use the clipboard to copy the chart elements and properties
ready to paste into a Word document. Once you have it in Word, select it and choose
‘Table,Convert text to table’ to make a neat report.

Summary of Keyboard Shortcuts
e F1 - gets help on any chart or property

e Enter — runs the current property sheet to rebuild the current chart

e Shift+Enter — opens up or closes up a branch of the tree

e Ctrl+Enter - edits the property setting in a pop-up form

e Alt+Enter — brings up the property sheet and notes page

e Ctrl+D - removes a chart or property

e Ctrl+I - offers a picklist of suitable properties for the current chart

e Ctrl+R - resets any property to ‘factory defaults’

e Ctrl+C - copies a property (or a chart and all its properties) to the clipboard
e Ctrl+V - pastes a copied property or chart

e Ctrl+X — removes a chart or property, but keeps a copy on the clipboard
e F9 - runs the completed chart

e F12 - toggles the thumbnail view to full-screen and back

Importing Data into GraPL

Sometimes, you have to generate your own data, but often it is already available on
someone’s hard-drive, very probably in an Excel spreadsheet. Although GraPL cannot
read Excel files directly, it makes it very easy to import spreadsheet data so that you can
plot it with the minimum of fuss. There are two basic methods:
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¢ using the Clipboard

¢ reading files saved in ‘CSV’ format

Both of these will normally be able to guess the column type and to import text,
numbers and dates correctly.

Using the Clipboard

To copy a block of data from Excel as a new GraPL datasheet, you should first copy it to
the clipboard, including its column headings:

A | = Mame

A | B | c© |
1 |Hame Date  Height
2 }Richard 02/06/00 178
3 [Richard 04/10/95 176
4 IRichard 05/09/95 175.5
5 [Richard 04/01,/99 165, 1
6 _[Richard 26/09/95 166
f_[Richard 03/01/95 155.3
8 |Richard 2310/97 157
9 |Richard 03/03/97 156.4
10 }Richard 02/01/97 1522
1 |Richard __ 05/10/36____ 1512
12 |Richard 01/06/96 1451
13 Rirhard FIANIGE 145 7

... then choose Edit,Paste as new sheet to define your sheet to match the data on the

clipboard:
CS¥ Import Options
[v Usze first row as column names QK
| Use second row az data units Cancel

Filtering
[+ Remove rows with fewer than EI: delirmiter(=]

Additional raves o discard

From kop: EI = From bottom: E =
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GraPL will take a quick look at the data, and guess if the first one or two rows should be
treated as column headers and units. At this point, you can also choose to discard data
from the top or bottom of the import, and to ignore rows with too few delimiters
(typically blank lines). Assuming that it guessed correctly, just hit <OK> to confirm the
properties of the new datasheet:

s Datasheet Properties
Sheet Mame LColurmnz . Drefinition of column - Mame
|HE|ght$ T Mame i‘ Tupe ... wdidth .
3 columrs Date |T:<t ﬂ | 72
Height

S - -]

Unecralled Cals: D : Calculated by ... Cal... | Func ...

[ Start with Form wiews

[ Auto-add new rows

[ Auto-add new calurng |

[ Fit prints to 1 page wide j Yalid choices, separated by commas

lTl = | Usze F2 [or just overtype] ta edit a calumn name. —
anee Drrag the rov stubs to re-order the columnz Q_D =

At this point, you can change the sheet name, and you might need to alter the column
types and add units information for your data. Choose OK to add the datasheet, which
you can now use for graphs and calculations as normal.

Please note that GraPL can only recognise dates which have been copied in the simple ‘short-
date’ format such as ‘25/12/98’ or ‘25-Dec-2001°. If you include the day of the week, you will
find that dates are pasted as a text column and you will not be able to use them as a time axis.
You should use Excel’s column formatting to change the date format before you copy the data to
the clipboard. The ordering of the date field will normally match your country, so if you are
running GraPL in the US, dates will generally be expected in MM/dd/yy format.

The same approach will work from any text data which is separated by commas or tabs,
for example a Word table or a text file loaded into Notepad.

Reading from text files

If you have data saved to a text file, either tab-separated or comma-separated, you can
use File,Import to read it into GraPL as a new datasheet. If the first row of the file
contains any non-numeric items, GraPL will ask if you want to use it as the column
names — otherwise they will just be named Col1,Col2 .... and so on. You can then clean
up the table definition in the property sheet (as above) and choose OK to add the new
datasheet.

If you read in very large files (say 10,000 rows by around 10 columns) you will need to
wait a few moments for GraPL to convert the text to the correct internal form (numbers,
dates, times). By default, GraPL is limited to using around 10Mb of memory (this is what
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the parameter Maxws=10000 on the program shortcut is for) — this is simply to prevent
‘runaway’ use of memory if you accidentally generate a huge table in a calculation. If
you get a WS FULL error reading a very large text file you should exit the program and
increase the amount of memory available, say to maxws=64000 if this is the amount of
‘real’ memory available on your computer. Alternatively, break the data into logical
chunks and import it into several separate tables. You can check the available memory
with Help,About.

Documenting what you did

When you import from a file, GraPL logs the file name and time into the datasheet
notes. You might like to use the Notes command (use the right-mouse menu on the
datasheet) to add a little more information about the data source.

Adding and Testing Calculations

Although GraPL is not intended to be a spreadsheet, it does have the ability to do basic
arithmetic between columns, and to make simple column-lookups between datasheets.
Several handy utilities are supplied for smoothing and averaging ‘noisy’ data to help you
see patterns in timeseries — all these can be applied as column calculations so that you
can see the resulting numbers as well as plotting them.

You can enter many of these formulae directly into the chart specification — it is up to you
whether you prefer to add extra columns to hold calculated data or just have GraPL work them
out on the fly when the values are plotted.

Simple column arithmetic in the data definition

When you define any column, you may add a simple arithmetic expression to have the
values calculated for you. For example in the sample file of fuel-consumption data, one
of the columns converts litres to gallons like this:

/" Column Properties [ x|

Colurnt name .. Width ... 0K
IGaIIu:uns I 42 Reset |

Cancel
Colurmn tupe ... Decpl... Unitz ...

INum j I'I j IGaIIDnS

Calculation [exprezsion bazed on other columns] ..

IFueI =027 Cal ... |Func .

[ ption list [chaice wpes only] ..

Walid entries for the 'One0f and 'Suggest’ types [zeparate with commas).
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If you add an expression like this, you will notice that the column is now shown on a
light grey background, and you cannot overtype the numbers. It can be used like any

other column in charts, or for further calculations.

Simple column arithmetic with the Calc tab

This gives you a more programmatic way to do basic arithmetic between columns, for

example:

Chartz Data ITE:-:t IEaI-: I

Sheetl

~IElS]

Col | Col2 | Total

Ehartsl Data I Text  Calc |

Calc [~
Object/Property | Yalue |
| |0 Comment Sum values
| |E] Arith coll +col2
Azgign to

Here we have simply added two columns together to make a total. You can also use any
of GraPL’s built-in functions here; these are listed for you by choosing View,Function
Crib from the main menu. For example if we make a data column of degrees (a good
example of a GrowBy formula such as 1g1 to fill a column in 1-degree increments) we

can use a calculation like:

Ehartsl Data Calc I

Calel |
Object/Property | W alue |
| |0 Comment Motes
| |E] Arith | Cos K _I
Azzign to CoEy
Chartz Data I Calc I
Cozine j
) | CoE

© Causeway Graphical Systems Ltd 2004
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This applies the cosine function to the column called ‘x’ and assigns the result to ‘cosx’.
In GraPL you can chain calculations like this to make really complex expressions, for
example if you would like to plot the log of the cosine, you would write:

Ehartsl Data Calc I

Calcl |

Object/Property | W alue |
| |0 Comment Maotes
|| Arith | log 240z » _I
Agzign to Cosd

... which reads “Log of 2 plus Cos x”. The rule is very simple — the argument to any
mathematical function is the entire expression to its right. This saves thinking about ‘do
I do times before plus’ but it can be confusing, particularly if you are used to a calculator
which typically involves pressing the keys in exactly the opposite order! When in doubt
use brackets to make things clear, so write this as “log(2+cos x)” or even “log(2+(cos x))”
if you are unsure.

Linking sheets with column look-ups

The data in the sample ‘heights’ project is a good example of why you sometimes need
to cross-refer between two data sheets. We can easily plot the boys’ height against date
to show 2 nearly parallel lines, but much more interesting would be to plot height
against age. If we add a small extra datasheet to record date of birth:

Charts Data IEaIu: I

DoBs j

M ame | DobB
Fichard .} 04410483
12/01 /86

Then we can use a Lookup calculation to generate a column with the birthdate repeated
for each child. Then all we need to do is to subtract this from the date the measurement
was taken and divide by 365.25 to get an approximate age in years.

Ehartsl Data Calo I

Ages j
Object/Property |"-"a|ue |
O Comment  Age calculation

| |E Lookup Heightz. M ame

Look in DoBzMame

Picking from DoBz.DoB

Agzign to Heightz.Dob

BEEL D ate - Heights Do) / 365.29 .. ]
Agzign to Age

Notice that I have two columns called ‘Name’ here, so in this case I needed to add the
name of the datasheet to make it clear which I meant. If you use the ‘..." button on any
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of the properties which can take a column name or expression, you will get a simple
dialogue box listing all the columns:

Editing - Lookup: Aszign to

T arget colurmn:

0k
Sheet | olurn | | itz Cancel
Heights I arne
Heightz D ate
Heights Height Help
Heights DaoB —
Heights Ange
DaBs M ame
DaBsz DaB

Double-click or press Chil+4, to add a column name

T arget column name for rezult. Thiz column will be replaced with the resulk of the calculation -
it musgt already exist.

When you click in the list of sheets and columns, GraPL will add “sheetx.colx” if the
column name occurs more than once, or just “colx” if the name is unique. If you do
leave off the sheet qualifier, the sheets are searched in order, so the first sheet with a
matching name will be the one GraPL uses when it looks for the column.

Calculation sequence

If you chain a series of calculations together, you should be careful to get them in the
right order. The sheets are run in order, starting with the first one in the stack, and the
lines in each sheet are run from the top down. This allows you to break complex
expressions apart, and to save intermediate results in temporary columns or scratch
variables so that you can check your logic. Scratch variables always begin with the
character ‘$’ and can be used to store intermediate results if you do not need to keep
them in a datasheet column. Any other name will be rejected unless it matches an
existing column.
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If you just want to see the numbers, open the Messages window (View,Console from the

main menu) and leave the ‘Assign to’ property empty. The results will be displayed in
the messages window for you to check.

s Messages, Trial Expressions and Debugging Output =] 3
|ze <Enter: to mwin the expr at the cursaor, Functions | Close
Expreszionz are separated with '#' and chained with & -

[Cal+12 // Sample
242 M el

Kl

Log cleared at 06/01/04 18:34
Debug. print =

TyT

131415

s

n o

Clear Log | Clear Exprz [ Echoinput line [ Show parzed expressions Bun

For a full list of calculations and arithmetic functions, see the reference section.

Documenting what you did

There are three places where you can add explanatory notes to your calculation sheets:

1. as comments after any of the input properties. Anything typed after a ‘//’ marker
is ignored.

2. as separate comment lines. Just drag the ‘lamp’ icon over from the Calculations
tab on the right and type as much text as you like. When you print out the sheet,
your notes will be wrapped into the right-hand column.

3. in a separate Notes page.

You can print out the calculation sheet (use the Print or Print Preview toolbar buttons or
the right-mouse menu on the sheet), together with any notes you made about it, as a
single document. Alternatively select all the rows and use the clipboard to copy the

entire sheet into Word, where you can easily format it up as a table and add extra
comments if you need them.

Printing Charts and Data

GraPL allows you to print your datasheets, completed charts, and the chart specifications
and calculation sheets. You can also use File, Overview to set up a complete report for all
the charts and tables in a GraPL project. You should complete the information in the
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File,Properties panel if you want your tables printed with a neat set of headers and
footers showing the project name.

Printing your Charts

To print your chart to the current default printer, simply hit the Print button on the
toolbar with the appropriate chart displayed in the thumbnail view and the Chart tab on
top. To print the chart when any other tab is on top, use the right-mouse menu from the
preview.

If you use the File,Print command from the main menu you will be able to choose a
different printer, set the number of copies and so on. This also lets you invoke the
printer’s Setup options.

Printing a Datasheet

Simply hit the Print (or Preview) button with the sheet shown in the Data tab. Note that
you can use the sheet properties to have one or more columns of wide sheets repeated
down the left of every part-page, or have the entire sheet scaled to fit on a single page
wide. You can also select Print Preview from the right-mouse menu, and choose a target
printer from there.

Printing a Chart Specification or Text Item

Either of these may be printed (or previewed) with the normal toolbar buttons or the
Print commands from the File menu.

Creating a Project Overview

You can create and save a simple list of ‘things to be printed’ using File,Overview from
the main menu. If you have made any general notes about the project as a whole (using
File,Properties) these will be included, as well as any of your charts, datasheets and
calculations that you want to have printed.

Simply drag the items you require from the tree on the left to the list on the right; if you
drag a ‘parent’ item like ‘Charts’ this will automatically include all the charts in the list.
You can re-organise the order of printing by dragging the items around within the list.
You can use Print Preview at any time to check how the report will look, or press Web
Page to export the entire overview as a single HTML file, embedding the charts as VML
text. Use OK to exit and have your list saved with your GraPL project.

Exporting Charts and Data

Although GraPL is primarily an engine for making, printing and exporting graphs, you
may find it useful also as a simple way to create HTML tables for your web pages. You
can also export your datasheets to text files (tab or comma-separated) or to the
clipboard. This section covers the various options for exporting the completed charts
and working tables.
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Saving your Chart to the clipboard

Virtually all modern Windows programs can paste data in ‘Windows Metafile format’

which is what GraPL uses when you select ‘Edit,Copy chart as Metafile’ from the main
menu. Alternatively you can use the right-mouse menu on the chart preview, or press
Ctrl+C when you have this zoomed to a full-screen view.

The chart will be pasted into (for example) Word, sized to fit the frame that you set in
the New Frame properties; by default this will be 6” wide by 4.5” high, but you can make
any shape you like here. Of course you can stretch the chart to fit your report once you
have it in Word or Excel.

You should use Options,Preferences to adjust two important settings which affect the
way GraPL saves data on the clipboard:

Chartz

J Copy charts ta clipboard in grepzcale

ﬂ Outline paper-edge when clipboarding

e Although coloured charts look very nice on the screen, some Windows printer
drivers make a very poor job of converting them to greyscale when you print them
on black and white printers. Select ‘Copy charts to clipboard in greyscale’ to have
GraPL do this for you; this will ensure you get really good black and white prints of
the charts in your finished report.

* You can also choose to have GraPL outline the edge of the ‘paper’ with a black
border - this usually improves the look of the charts in the final document.

If you are developing a webpage for display by Internet Explorer you can also choose to
copy the chart to the clipboard as VML. This is a text description of the graphic in vector
format and you will be able to paste it directly into any web-page development tool. You
will need the correct information in the header of your page also — use File,Export chart,
Webpage to make a simple (standalone) page containing your chart in VML format and
take the necessary details from there.

Exporting the Charts to File

GraPL supports a wide variety of export formats, suitable for different applications:

e Webpage (VML) — this saves a complete webpage (with the .htm extension)
including the chart as VML markup. You can load this straight into IE (5.0 or
higher) to see the results. This is an excellent format if you know your users will
have IE, for example for publishing on an Intranet. The VML representation will be
much smaller than an image file, and it will print at very high quality direct from
the browser.

e Scalable Vector Graphic (SVG) - this is a ratified internet standard (see
www.w3c.org for more details) which may be supported in the future by many
major browsers. It currently requires a plug-in viewer (from Adobe) so this format
is not yet suitable for production use on the internet. It is excellent for in-house
use, and the rendering quality is generally a little better than the VML version of
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the same chart. SVG files support animation and a wide range of other special
effects.

e PNG image - this saves the chart as a compressed image file with the .PNG
extension. This is the best format for publishing graphics on the Internet if you
cannot rely on IES availability. However it does not (yet) support the full range of
gradient fills and opacities which may be used in the various vector formats.

e Webpage with Image - this saves the chart as a PNG file and a companion webpage
as simple HTML.

e EPS format - this saves the chart as Encapsulated PostScript, which is suitable for
any high-end publishing tools. You should definitely use this format if you are
preparing material for publication in a journal or newsletter which will be
professionally printed. You can import EPS pictures into Word to check the layout
but Word can only display simple header information on screen. Your documents
will print correctly on a PostScript printer.

e Windows Metafile — this saves the chart in Windows Metafile format as a file with
a WMF extension. Most Windows programs can import and display this style.

e Portable Document Format (PDF) - this saves the chart for viewing with Adobe’s
Acrobat Reader. This is a good format if you need to send graphics to users on a
non-Windows platform, such as a Macintosh, and be sure they display correctly.

e Raw PostScript (for PDF) — this saves the chart in bare PostScript for use by Acrobat
Distiller to make PDF files. You may also send the output directly to a suitable
PostScript printer such as the Tektronix 840 or any Xerox Phaser. Simply type the
device name (such as “\\server\hplj”) when prompted for a file.

If you need other file formats, you can use a package such as Paint Shop Pro to convert
the PNG files to a wide variety of bitmap formats, or CorelDraw to process the charts
saved in WMF format. You can also paste the charts into PowerPoint and use the right-
mouse menu Grouping,Ungroup to break the chart apart so you can move parts of it
around, add fancy fill effects and so on.

Exporting Datasheets to File

GraPL supports three simple text-based formats:

e CSV for Excel - this saves the datasheet as ‘comma-separated values’ for loading
into Excel or many other spreadsheet or database products.

e Text (tab-separated) — this saves the datasheet as Tab-separated text. This is also
suitable for Excel and many other products. It is probably the best format if you
want to import the data into Word as a table.

e Save as Webpage — this saves a complete webpage including the datasheet as a
table. You can load this directly into Internet Explorer, or use Cut-and-Paste to put
the table into your own webpage.

You can use either the CSV or text options to move data between GraPL and Excel.
When you save in HTML format, GraPL applies the column formats (such as Num2 to
round the data to 2 decimal places), and also appends any notes you have made about
the sheet. To copy a datasheet into another GraPL project, use File,Import sheet,GraPL
project, which will copy the column formats and notes as well as the raw data.

© Causeway Graphical Systems Ltd 2004 28



Getting to Grips with GraPL

Setting Line Colours, Fill Patterns etc.

Rather than making you set the colour and style of every line and bar individually,
GraPL uses the concept of cycles of colours, styles, patterns, markers and nib-weights so
that you can set these up in advance and have your data-series use them in sequence.
The defaults are carefully arranged to ensure that it takes a long time for a particular
combination to come around again, so you can safely plot a large number of series on
the same set of axes without worrying about repeating the same set of (say) style and
marker in your key.

Templatesl Chart elements  Settings | F'ru:upertiesl

I —_— I EA B L -
I zoees * =z — (f coneee T
Colours Lines Markers Fatterns Mibs Effect:  Define dash
Ao oy v
Define mark.  Define tile  Define font Define Mamed Mamed Mewline
effect chart ZENEs -
Global zettings should normally come before the first chart

The Settings tab lists these for you, and you can add any setting to your current chart by
dragging it to the specification. The settings apply from the line where you add them,
downwards, so you can add several copies of (say) the colour setting if you want explicit
control over the colours used by particular charts.

If you have a ‘house style’ set of colours which you want to use consistently, you can
make a simple template which just has the colour cycle set up for you and use it as the
basis for all your charts, or you could update the default cycle permanently using
Options,Global Defaults.

Defining a colour cycle

Suppose you are plotting some data where the colours have a natural significance, say
total goals scored in the English, Italian and Dutch football leagues. Obviously you want
the English in Red, the Italians in Blue and the Dutch in Orange, so if the data table
looks like this:

Charts Data |Te:-:t I

Goals | E'_l El

England | lItaly | Halland |

55 S—— 10 18 7
- 12 16 3
8 14 3
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... we would add a colour cycle at the top of the chart specification and set it to 3
colours:

Editing - Colours

Fed
Blue
HECECZD

Predefined colours:

o

] Cancel Reszet | Help |

As you click through the colours in the cycle, the chosen colour is shown in the large
swatch at the bottom. You can choose any of the 16 ‘base colours’ from the set of
buttons or press the ‘... button beside the colour swatch to bring up the standard
Windows colour-chooser. Your colours will always be shown in the list in the standard
HTML style as ‘#FFCCOO0’ strings or the colour’s name (like ‘Maroon’) if you choose a
base colour. For charts to be published on the internet, it is best to stay with the base-
colours, or the published list of ‘Netscape-safe’ colours if you can.

My completed chart specification now looks like:

Chatts | Data | Text |

Lires & Markers j

Object/Property | " alue |
| ] Hew Frame 00432324
|| Style YWiped, Boxed
|| M arginz [thir] 42.4836.18
|| ‘. Heading Goalz Scored eac
| |00 Colours Red.Blue BECBLC:
| |00 Lines Solid
| |E Linegraph goalz
|| Wersus

iLineqgraph Stlef| Lines Markers ..

You will notice that I have also reset the default line-style sequence to ‘Solid’ as I do not
need to print these lines on a black and white printer.
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Setting the line-styles

This setting uses a very similar screen to the colour-chooser:

Editing - Lines | x|
Pre-defined line-ztyles
CE — T

Drotted
Drat-dazh
Drazh-dot-dot
[reveizible
[uzer-defined]

k. Canicel Bezet Help

Here you can see I have chosen to alternate solid and dashed lines. You can make the
cycle as long as you like, or simply set it to 1 if you want all your lines the same. You can
pick from any of the 6 pre-defined line-types or add a custom dash-pattern of your own.

Setting a marker cycle
This is mostly used for scatter plots where you have several categories of data plotted
against the same set of axes.

Editing - Markers

Fre-defined markers

Lrass Triangle N
Pluz Dl
Diamu:unu:l Ll:?zenge
: Black
Del Irwvisible
Lozenge A1 -1 pinel
A2 -5 pixel
A3 -9 pixel
A4 -7 pivel
Ak - P4 nivel j
k. Canicel Bezet | Help |
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Again, you can add your own markers to the list, for example by using characters from
the WingDings font. You can also choose to scale the markers, independently of the
chosen nib weight. You will need to add a ‘Marker scales’ property which may be a
single number (as shown here) or may refer to a data column if you want the marker size
to reflect the data values.

s C:hData\grapl SEATRIALY GOALS.GPL - GraPL
File  Edit Insert \Wjew Data Preview Options  Plugins Help

DEedMEReEes » | XE | v ® | 8 | 5.8

Chatts | Data | Tent |

Lines & Markers j
Dbjzct/Property | Walue | Craals Scored each Week

| |Z New Frame 00432324
= Shyle Wiped Bozed
= b arginz [thir] 42,4836.18
= L@ Heading Goalz Scored eac
| O Colours Fed Blue #ECEC:
| |0 Lines Solid
| |0 Markers Ball
e
| & Linegraph goals
|| Mersus

Marker scales 3

Linegraph Style  Lines Markers

|[10] Nib-weight cycle | | SVB [Ciil to 200m)

Here I set the marker cycle to a single value (the 3D ball) and scaled them to 3 times
normal size.

Setting nib weights

By default, GraPL sets the nib thickness at 0.3 points, which equates to a 1-pixel line on
screen and a nice hairline on the printer. You can set this from a selection screen (as for
lines and markers) or simply type in a list of numbers here. In the example above, I have
increased the nib weight to a 3-point line which looks much better on screen.
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Setting a pattern cycle

GraPL uses a default set of shading patterns for barcharts and piecharts, again with the
objective of making your charts print well on black and white printers. Also you will
find that half-tone colours work better on screen for most normal charts. However, if
you want to set up some special effects, add a ‘Pattern cycle’ above the chart, and set the
cycle length and pattern for each element:

Editing - Patterns | x|

20% colaur

305 colaur 80% colaur
|10 colour 90% calour
(602 colour B ackground Fill
Left stripe
Right stripe
Hatched
Fizhezcale
Bricks

F Ak at W manes

Fre-defined fill patternz

L

k. Canicel Bezet | Help |

For our football example, we probably want solid colours everywhere, so a cycle of
length-1 with ‘Solid’ set for all the bars is all we need:

s ChDatagrapl SEATRIALYGOALS.GPL - GraPL
File  Edit Insert  Wiew Data  Preview  Opkions  Plugins  Help

edEk bR~ | XF | wek¥ | sgadlle | E-8

Charts |Data I Text I

Basic bars j
Object/Froperty | Value | Goals Scored each Week
| |[] Hew Frame 00432324 124
| Shyle Wiped Bozed
L td arginz [thir] 42.48,36.18 7
- ‘@ Heading Goals Scored eac 14
|00 Colours Red.Blue HECELC:
| O Patterns Solid i
|| Barchart goals 10
H-labelz a2 |
|| Key goalzfcols
Barchart style  Forcezero 7

1 2 3

B England EEE [ialy O Holland

[8] Pattern cycle Dane SWG [Chl to zoom)

£
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Notice that this also sets the colour and pattern used in the key, which has been set to
pick up the column titles here. If you are using VML or SVG in the Preview pane, you
can experiment with a variety of simple gradient fills here also.

Defining your own line-styles

You can set any repeat pattern of dots and dashes by adding a ‘DefineDash’ setting at the
top of your chart specification. Here you give the dash-pattern a number, and then the
repeat pattern with any combination of ‘line-gap-line-gap’ values in points, say “12,15
14 6 14” to make repeat pattern number 12 have a 15-point line, a 14-point gap and so
on. Obviously, you must give an even number of values here. To refer to the custom
style in your line-cycle, just give a list like “Solid,Dash,12” — you can use any numbers
you like for custom patterns as long as you keep clear of the preset numbers.

Defining your own markers

The various Windows typefaces provide a rich source of good graphical markers to be
added to the built-in set. For example the characters JKL provide the happy, neutral and
sad faces ©©® which might be ideal for our football scores. More usefully, you might
like to plot the results from a chemistry experiment with the string ‘pH’ as your marker
on a scatterplot.

To use the smiling face as a marker in a scatter plot, add a ‘Define mark’ entry to your
chart definition and fill in the required font, the point-size and the character you want
as the marker:

s ChDatagrapl SEATRIALYGOALS.GPL - GraPL
File  Edit Insert  Wiew Data  Preview  Opkions  Plugins  Help

eEdEk bR~ | XF | we k¥ | aadlle | E-8

Charts |Data I Text I

Defined mark.er j

Object/Froperty | *alue . - .
|2 New Frame |D,D,432,324 | England & liah
| Shyle Wiped Bozed 12 @

L t arginz [thir] 54.48,36.28
| ‘[ Heading Enaland & Italy

|0 Colours Fed Blue HECBLC: 14
| |0 Define mark  23.wing.12.)
| |0 Markers 23
| |E Linegraph England 1] @
|| Mersus Italy
Marker scales 3

Linegraph Style | [GETEEE 0

|[1 2] Plat Style | | SV [Chl ta zom)
o

Here I have defined the new marker as number 23 (use any number you like as long as it
is greater than 16) and applied it to my marker-list before running the scatterplot. To
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refer to characters which are hard to type (such as the Windows logo which is the very
last character in the WingDings font) you can give the decimal index of the character
preceeded by ‘#’ e.g. the ringed numbers which start at #139 can be very good markers.
Use Charmap (in the Windows, Accessories menu) to select an appropriate symbol, and
read the number from its statusbar, or just paste the character directly into GraPL.

Defining fill patterns

GraPL provides a good set of basic fill patterns for bars and pies, however there are
plenty of requirements for specialist fills, for example geologists like to shade limestone
with just the right kind of irregular block. To make a custom fill, you must first draw it
and save it as a bitmap (e.g. using Windows Paint) then you can add a ‘Define tile’ entry
to your chart definition, give the pattern a number as for lines and markers, and use it
anywhere a fill pattern is required. The example adds a column of data for Scotland and
uses a tartan pattern for the bars:

s ChDatagrapl SEATRIALYGOALS.GPL - GraPL
File  Edit Insert  Wiew Data  Preview  Opkions  Plugins  Help

edEk bR~ | XF | wek¥ | sadlle | -8

Charts |Data I Text I

Tiles j T ———
Object/Property | Value | Goals Scored each Week in Scotland
| |[] Hew Frame 00432324
| Sthyle Wiped Bozed
L ¢ Margin [tblr) 42,48,36.18
- ‘[ Heading Goals Scored eac
| |0 Define tile 25, c:hdatahartwor
|0 Pattemns 25
|| Barchart
| Helabels ATt
Barchart style  Forcezero

|[E|] Draws a barchart | | A

Here I have defined tile number 25 as the bitmap “c:\data\artwork\tartan” and set the
pattern cycle to use it. Obviously you can use any standard fill pattern here — Paint Shop
Pro comes with a good selection of background fills for nice relaxed effects.

Adding extra font codes to the supplied list

GraPL comes preset with Times, Arial, Courier, Symbol and WingDings defined with 2-
letter short codes (see Options,Font list to change the default set). If you stay with these
fonts, you will ensure that your charts are completely portable and work well in any web
browser (not just on Windows). However you may want to add new abbreviations to
give you access to any font on your computer - in the example [ have added Comic Sans
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with the short code ‘cs’ to allow me to use it italicised in the heading and bolded for the
axis labels.

Defined Font (Uncial)

If you want to add a font that only comes in a single flavour (such as WebDings) you
can use up to 4 characters for the short code, otherwise it is best to leave the last 2
characters free to be used for the ‘b’, ‘i’, ‘bi’ suffixes. Once a font is defined, you can use
it anywhere GraPL expects a short-code, so if you have a set of non-standard fonts which
you use regularly, you might consider adding them to a template so that they are always
available.

Creating and Using Templates

The leftmost tab on the right-hand side of the screen is there for you to collect your
favourite chart styles, so that you don’t have to build them up from scratch each time.
GraPL is shipped with a few simple templates as examples (such as the ErrorBars chart)
which you can examine, modify or discard as you like.

If you don’t use this tab, select Options,Preferences (p.41) from the main menu and
uncheck it to have it hidden in the future.

How templates are stored

A GraPL template is simply a text representation of the chart specification, with any
references to column names changed to read {data} so that it refers to the {data}
generated series when you use it again. Templates are saved with a .TXT file extension in
the Template folder (by default — you can change this from the Preferences dialogue) so
that you can edit them with Notepad, move them around with Windows Explorer, put
them into mail messages to send to your friends and so on.
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A typical template looks like:

[Header]

Author=adrian

Created=08/09/00 11:01
Saved=08/09/00 11:01

Name=Error bars!

Descr=Simple errorbar example
Icon=7

[Properties]

New Frame:New:0,0,432,324
.Style:BS:boxed,wipe
.Margins:MG:42,48,36,18
.Heading:HE:Sample Timeseries with Errorbars
..Font:HF:TII,18,Navy

..Style:HS:

Linegraph:Plot:{data}
.Style:ST-L:1ines ...... and so on

The header part is what you see when you use the right-mouse menu on a template icon
to access its Properties:

+~ Template Properties [_ |O]
Captiar ... Author
|Err|:|r barsl |a|:|riar'|
Dezcrption ...

|Simple ermorbar example

Saved on file: ohdatahgraplhtemplatetERRORBAR. T=T
Created on 03/09/00 11:01
Last gaved on 08/09,/00 17:01

Bar Plot Scatter Fie Paolar xbhar J
I1! Lil ]éaé ﬂ'é; Li‘ G

*lin Freq B o=plat Gantt Step Trace ﬂ
k. Cancel | Choose a suitable icon for your template here.

This dialogue also lets you pick an appropriate icon from GraPL'’s collection of chart
miniatures. The [Properties] section of the file has one line for each line in the chart
specification. The indenting is determined by the number of leading dots, so you can
easily tidy this up in a template file. Each line then consists of three elements:
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e the text description of the chart or property. You can make this anything you like
— it will be used in the left-hand column of the tree to describe the line.

¢ the internal GraPL chart name or short code (‘HS’ is a heading style) for the
property.

* the property setting (exactly as it will be shown in the Chart tab)

When you base a new chart on a template, GraPL always reads the latest version from
file so you can check your work by saving the template from Notepad, switching to
GraPL and dragging the modified template across to the Chart tab. If you change the
header information, or copy a new file into the templates folder, you will need to choose
View,Refresh templates (or press F5) to have your changes show up in the Templates tab.
You can preview a template at any time by selecting it in the Templates tab and pressing
F1 or selecting ‘Preview template’ from the right-mouse menu on a template icon.

Saving a chart as a template

Typically, you might set up a simple chart with your choice of fonts for headings and
subheads and a standard footnote such as ‘Printed on {date}’ See Field codes for more
details.

Charts | D ata I Calc I

Barchart example j

Cbject/Property | Walue

|| Mew Frame 00432324

Style bowed

| karginz [thir] 5E.48,36.28

El Heading Heading goes Here

N Placement  left
|| =B Footer Printed on {date}
| Placement  Right
| Fort Helv.10,Faorest
|3 Barchart {data}
Barchart style _I
|| Gap 1]
Bar edge nea

This example also sets the ‘forcezero’ style, takes out the gap between bars and increases
the footer font a little. You can check out the appearance in the chart thumbnail, and
when you are happy with the effect, select File,Save as template which will first ask you
for a file name (the default is the name of the current chart sheet).

Text input

Filename far new template .

B archart exarmple. bt

2k, Cancel
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... and then allow you to pick a suitable icon and give the template a more helpful
description:

s Template Properties

M=l
Caption ... Athor
|B archart example |a|:|rian
Descriptiorn ..

|Bar|:hart with adjacent bars and pozitioned headingz

Saved on file: o:hdataharaplhtemplateBarchart example. txt
Created on 1109400 11:45

Lazt gaved on 11/09/00 11:48

W i L @ © g
Bar Plot Scatter Fie Paolar #bar

{11! i LA S T - -
(] Cancel | Chooze a suitable icon for pour kemplate here.

When you choose OK here, the definition will be saved for you as a text file in your
template folder and the Templates tab will be updated. If you want to see the longer
descriptions here, select View,Details to put the list of templates into ‘Report’ style:

Templates l Chart elements] Settings] F'ru:uperties] Ealculatiuns]

T emplate | D ezcription -

L Blark: & blank chart

(YR E archart example B archart with adjacent barg and positioned headings

112t Error bars! Simple ermarbar example

K7 Headings Check out zubstitutions I
M Fiechart Simple piechart with exploded sector
|l Chorcbart é ctar ket avarnls hd
Dirag owver the chart property-sheet to uze az a new chart, prezz F1 to preview
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Making a new chart based on a template

The easy way to do this is just to drag the template icon over the Charts tab. You will be
given the choice of replacing the current chart or adding a completely new definition —
you can also change the suggested name and add some notes at this point:

s Add Template as Hew Chart

M arne: |Bar|:hart

Maotes: |Created from barchart template J

[

(¥ | Heplace existing definttion: € Add as new chart

aF. Cancel

Now all you need to do is change the {data} placeholder to refer to your datasheet and
the chart is ready to use.

Note that you can change the chart type here (use the right-mouse menu on the chart
element) but you will probably have to collect some extra properties to make it work for
you - for example if you change the Barchart to a Linegraph you will need to add a
‘Linegraph style’ before it will draw anything for you!

Summary - benefits of templates

Templates can obviously be a major timesaver, but also allow you to mould GraPL to
behave as you want. You only need the properties in the chart specification which you
actually use, and you can arrange them in any order you like. You also get a much more
consistent appearance — if you like brick-red bars you can add a Colour cycle (p.29) to
your barchart template which sets this as the first colour, and so on.

Once you have a set of templates that you like, you can easily move them around, tidy
them up in Notepad, attach them to mail messages and so on.
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Setting Preferences and Global Defaults

GraPL has a single Preferences panel which lets you customise the interface and choose
the location of your templates folder:

. Preferences

Charts Show template and stencil tabs

| Copy charts to clipboard in greyzcale W Templates [part-completed chartz)

[ Outline paper-edge when clipboarding v |ndividual Chart Elements

. v Global Sett I t
[v Redraw chart automatically geslbeti el

[v |ndividual Properties
[ Always show full properhy list

[ Advanced Calculations
D ata sheets Shaows chart creation and data entry tabs

[ Re-order rows by dragging row stubs IV Chart specifications

v | Be-order columns by dragaing headers v Data-entry sheets or Foms

. o [+ Motes and Macros
[ &llow sorting by clicking column headers

[ Calculation sheets
[ Update chart immediately on changing data

[ Automatic cell-edit mode

Prefemed unitz: | Fointz -
Filez to keep on MR list: =

Default folder: |cdata'arapl

| oK | Lancel | Templates folder: |c\datataraplternplate

b ax iterations for cyclic calculations: 12

The top set of checkboxes allows you to choose which of the right-hand tabs you want
to see, for example if you never use templates, just turn this tab off.

The left-hand panel controls how datasheets behave:

e If you allow sorting by clicking the headers, it is very easy to sort a column by
accident! Enable this option to sort your tables, sort them, and turn it off again to
prevent accidents.

e Normally, GraPL will only rebuild the current chart when you ‘commit’ a bunch of
changes on a datasheet by pressing Enter or hitting F9. You can enable the second
option to have the chart redrawn on changing every cell.

e If you frequently move columns around (maybe to make a variety of different
export tables) it is very handy to allow GraPL to do this by dragging the headers,
rather than having to use the Properties panel for the datasheet. Again, it may be
better to leave this option off otherwise, as it makes ‘drag-selection’ of a bunch of
columns very difficult.

e [f you set ‘automatic cell edit’ GraPL assumes you want to edit each cell as you get
to it, rather than waiting for you to type something into it or hit F2. For numeric
sheets this option is much better left turned off.
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The right-hand panel controls two settings on how charts are copied and exported:

e by copying charts in greyscale you will improve the look of finished reports when
printed on many black and white printers from Word etc. This is because GraPL
takes care to map the colours sensibly to grey shades, whereas many printer drivers
do it very badly, and some colours may disappear completely.

¢ if you outline the paper edge you will get a nice ‘paper’ effect on images exported
for web graphics (PNG or VML format) and a border drawn around any charts you
clipboard to Word. Experiment to see if you like this effect.

Finally, you can set your default units, the number of files GraPL should remember on
the history list (shown at the bottom of the file menu) and the location of your data and
templates folders. The templates folder can either be a full pathname (as shown here) or
the path relative to your GraPL program folder (the default location is just ‘\template’).

Making a collection of ‘house fonts’

GraPL is shipped with a table of short-codes for the basic Windows and PostScript fonts
(Times, Arial and so on). This allows you to type in font settings quickly and reliably, but
it may contflict with your house standards, for example it might be a standard that all
major headings should be in Arial Black, which is not on the list. However you should
try to stay with the standard set for any charts you intend to publish on the internet in
VML format.

You can edit the current set of font codes (to re-order them, add new fonts and so on)
using Options,Global Defaults from the main menu. The font-table is saved in a simple
text format as defaults.txt in your GraPL program folder, so if you prefer you can safely
copy and modify it in Notepad or any other text-editing tool.

Keyboard Shortcuts
General
e Ctrl+N - starts a new GraPL project
e Ctrl+S - saves the currrent project
¢ Ctrl+O - opens an existing file
e Ctrl+P - prints the current object (chart, datasheet, calculation)
e F1 - gets help on the current item
e F2 - puts the datasheet into cell-edit mode
e F5 - refreshes the Templates tab
e F9 - runs the completed chart
* F11 - zooms the current datasheet to its own window

e F12 - toggles the thumbnail view to full-screen and back
The Specification Sheet

e F1 - gets help on any chart or chart property

e Enter — runs the current property sheet to rebuild the current chart
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Shift+Enter — opens up or closes up a branch of the tree

Ctrl+Enter — edits the property setting in a pop-up form

Alt+Down — moves to the next chart

Alt+Up — moves to the previous chart

Alt+Enter - edits the chart property sheet

Ctrl+] — inserts a new property (picked from selective list)

Ctrl+D - removes a chart or property (and its children)

Ctrl+R - resets any property to ‘factory defaults’

Ctrl+C - copies a property (or a chart and all its properties) to the clipboard
Ctrl+V - pastes a copied property or chart

Ctrl+X - removes a chart or property, but keeps a copy on the clipboard

The Data Sheet

Ctrl+F - finds any value in the current column
F3 - reruns the last ‘Find” with the same value
Ctrl+T - toggles into Table view

Ctrl+M - toggles into Form (row-by-row) view
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Acrobat Distiller 28

Adding a new data sheet 9

Adding and Testing Calculations 21
Adding chart elements 16

Adding Charts and Properties 6
Adding or removing columns 12
Arith 21

B

Build charts 14

C

Calculation sequence 24
Calculations 21
documenting 25
Chart
save as template 36
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documenting 18
keyboard shortcuts 18
moving 17
printing 26
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removing 17
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exporting 26
printing 25
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importing 18
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deleting 12
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ordering 12
properties 12
Comments 25
Cosine 23
CSV files
exporting 26
importing 18
Custom line-styles
defining 34
Custom markers
defining 34
Custom patterns
defining 35
Customising
main screen 7
Cycles
colour and style 29

D

Data
entering and organising 8
importing 18
Data sheets
adding 9
cell copy 11
exporting 14
exporting as CSV 28
fill down 11
one-click sorting 13
printing 14, 26
save as webpage 28
Data tab 5
Data type 10
Datasheets 8
properties 9
Dates
arithmetic 23
Define
colour cycle 29
custom 34
line-style cycle 31
marker cycle 31
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nib-weights 32
pattern cycle 33

E
Editing
chart specification 14
Entering data 11
EPS (Encapsulated PostScript) 28
Error bars 17
Exporting 26
Exporting charts
clipboard 27
file 27
Exporting datasheets
CSV 28
tabbed 28
webpage 28

F

Fill down 11
Fill patterns 29
defining 35

Fonts 41
defining 35

G

Grow by 11

H

HTML 26

I
Importing
clipboard 19
Excel 18
text files 20
Importing data 18
Installation 2
Internet Explorer 27
Introduction 4

K

Keyboard shortcuts 42

L

Line colours 29
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Line-styles
custom styles 34
defining 31
Linking datasheets 23
Lookup 23

M

Manuals
printing 3
Marker cycle
defining 31
Markers 29
defining 34
Maxws 21
Memory
available 21

N

Network use 3

New template
adding as a chart 17

Nib weights
defining 32

Notes (comments)
calculations 25
chart 18
data 11
datasheets 11
importing data 21
project 8

O

Objects

adding and removing 16
Organising data 8
Overview 8§, 26

printing 26

save as webpage 26

P

Pasting data from the clipboard 11
Pattern cycle

defining 33
PDF (Portable Document Format) 28
PNG (image file) 28
Preferences 41
Printing and exporting data 14

45



Index

Printing Charts and Data 25
Project properties 8
Properties
adding 7
adding and removing 16
moving 17
Property Tree 15

R

Reading from text files 20
Registration 2

S

Save as Webpage 26
Scratch variables 13, 24
Settings

colours 29

markers 29

patterns 29
Sorting the datasheet 13
Statusbar 7

T

Templates 36
creating 36
creating from a chart 38
properties 37
using 40
Text files
importing 20
Text tab 5
Thumbnail view
zooming 18

VvV

VML (vector graphics) 27

W

Windows Metafile 28
WS FULL 21

© Causeway Graphical Systems Ltd 2004 46



